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Allen-Bradley Micro800 Series Driver (vi.o1+)
Information Sheet for Crimson v3.0+

Compatible Devices

e Allen-Bradley Micro800 Series PLCs

Verified Device

e Micro820 2080-LC20-20QBB

Overview

The Micro800 Series driver allows access to data tags in Allen-Bradley
Micro800 series PLCs. It also provides a method to import tag definitions
from Connected Components Workbench into Crimson 3.0+.

Serial Configuration

In Rockwell Automation’s Connected Components Workbench (CCW)
software open the Project Organizer window via the View Menu then
double click on the controller at the top level of the tree in the Project
Organizer window to open the controller tab.
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File Edit View Device Tools Communications Window Help

Al U - P +|| & = _ ®. Disconnected - iy 4 1, _
<  Terminal Application Language 5

Project Organizer ¥ R X | Progl-POU Micro820 + < N

MName: Project2 Micro820
kIR
21 Micros20
& 1 a

=gl Programs Download ~ Upload  Disgnose -~ Secure~

=B Progl

= Local Variables
] ) 2080-LC20-200BB - . -
&l User-Defined Function Blc I )| o

&9 DataTypes

= Controller “ | Contraller
. General
- Memory

i L Startup

Serial Port

© . Modbus Mapping
.. Real Time Clock -

ALLEN-BRADLEY MICRO800 SERIES DRIVER INFORMATION SHEET FOR CRIMSON V3.0+



In the Controller tree within the controller tab, click on Serial Port.

Project Organizer ~ J X | Progl-POU Microg20 & x (g
Name Project2 Micro820 Run
Remote Run Program
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LGRS Program
1] Microg20
m K K @
- gl Programs Download ~ Upload  Diagnose Secure
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= Local Variables
Global Varizbles
2080-.C20-200BB
i@l User-Defined Function Bl
59 DataTypes
- Controller 4 Controller - Serial Port
i i General
i Memory Common Settings
. i-Startup } -
Driver: CIP Serial
I 1. serial Port Ter (]
- Ethemnet Baud Rate: 38400
L. Interrupts
Parity: N
Modbus Mapping arity ons
Real Time Clock - Station Address: 1

Set the Driver to CIP Serial and note/adjust the Baud Rate, Parity and
Station Address in that they are suitable for the application.

In Crimson’s Communications category select the desired serial port in the
Communications tree and click on the Pick... button.

navigation Ranes X, | Communications - R5-232 Comms Port

goliens X Driver Selection
& Communicatians ~
Driver: | No Driver Selected |

= & Metwork
i protocol 1
" Protocol 2 Port C
T~ Protocol 3
i Protocol 4 Clear Port Settings

(= &) serial Ports Add Additional Device
<) R5-232 Program Port
=) R5-455 Comms Port A
=) R5-232 Comms Port
<) R5-485 Comms Port &

B & USB Host Ports Driver Picker for Serial Port [ = ]
B Memory Stick
Keyboard - Manufacturer -~ Driver
= Mouse <« System> - No Driver Selected -
=) i Connectors BB a DF1 Master Version 1,02
Generic MQTT ACTech . DH485 Master Version 1.02
Amazon MQTT Adam
Azure MQTT Native Tag Addressing Version 1.01
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= 5 services Applied Motion
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(= Mail Manager Total of 172 Drivers Available.
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Find the Allen-Bradley Micro800 Master communications driver as shown
above and click OK.
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Modify the Baud Rate and Parity settings such that it mirrors the port
settings in the CCW software.

=) RS-232 Program Port
=]} R5-435 Comms Port A

m PLCL

= =) R5-232 Comms Port - Micro800

Data Link Layer: Full-Duplex -
Frame Validation: |CRC 7

_Navigation Pane X  Communications - RS-232 Comms Port

ﬁ‘ New s X Driver Selection

& Communications -

= ?'!- Metwork Driver: | Allen-Bradley Microd00 Master | Pick...
8" Protocol 1
i Protocol 2 Driver Settings
" Protocol 3
T Protocol 4 Source Address:

=l @ Serial Ports

Port Settings
=) R5-435 Comms Port B
= & USB Host Ports Baud Rate: 38400 -
B Memory Stick
Data Bits: Eight -
[ Keyboard
%? MG::E Stop Bits: One -
= onnectors
Generic MQTT Parity: None -
Amazon MQTT
Azure MQTT Port Sharing
Sparkplug MQTT
Cumulocity REST Share Port:  MNo - 0
= % Services
@ OPCUA Server Port Commands
[E3 Time Manager
Q\ FTP Server Clear Port Settings
pdk Sync Manager Add Additional Device

=) Mail Manager
==

Driver settings are available as follows:

Source Address: Configure the unique address that will represent
the Red Lion device on the CIP network.

Data Link Layer: Select between Full-Duplex or Half-Duplex
communications. This should be configured to match the setting
used by the Micro800 PLC.

Frame Validation: Choose from CRC or BCC for the frame
validation. This should be configured to match the setting used by
the Micro800 PLC.

In Crimson click on the PLC device and set the Station Number to the
same number as the Station Address in the CCW software.

w & ‘Communications - R5-232 Comms Port - PLCL
New »
ﬂ - x Device Settings
5} Communications -
= ?& MNetwork Enable Device:  Yes -
q{' Protocol 1
E’f Protocaol 2 Tag Mames
q{' Protocol 3
T Protocol 4 Manage... ‘ I Import.. ‘ I Export...
= Q Serial Ports
=) R5-232 Program Port - .
<) R5-485 Camms Port A DeeDpians
= =) R5-232 Comms Port - Microd00 Station Number:
[1: sl
=) R5-485 Comms Port B Transaction Timeout: | 1000 = ms
= & USE Host Ports
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Device settings are available as follows:

Transaction Timeout: This is the amount of time that the driver will

wait before a transaction is considered to have failed. Shorter times
will detect failures sooner, but longer times will be more tolerant of

slow connections.

Ethernet Configuration

In Rockwell Automation’s Connected Components Workbench (CCW)
software open the Project Organizer window via the View Menu then
double click on the controller at the top level of the tree in the Project
Organizer window to open the controller tab.

Project Organizer
Name: Project2
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In the Controller tree within the controller tab, click on Ethernet.

Name: Project2
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=B Progl
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= Global Varizbles
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S DataTypes

Micro820
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Download  Upload
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Controller
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Startup
Serial Port

. Interrupts

Memory Card
Remote LCD

Data Log
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Plug-in Modules

- Modbus Mapping
. Real Time Clock
Embedded /O

Diagnose - Secure~
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“  Controller - Ethernet
@ Diagnose
Internet Protocol (IP) Settings

@ Obtain IP address automatically using DHCP
) Configure IP address and settings

IP Address:
Subnet Mask:
Gateway Address:

Detect duplicate IP address
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Configure an appropriate IPv4 address according to the network
requirements. Please consult your IT department for assistance if
needed.

In Crimson’s Communications category select an available protocol in the
Network element of the Communications tree and click on the Pick...
button.

avigation Pane. K] | Communications - Network - Protocol &
Slisas ] X

Driver Selection
& Communications -
5 & Network B Driver: | No Driver Selected |
" Protocol 1
S Protocol 2 Port €
S Protocol 3
5 Protocol4 Delete Netwark Port

= %) Serial Ports
=) R5-232 Program Paort
<) R5-435 Comms Part A
=) R5-232 Comms Port
=) R5-435 Comms Port B
=) & USB Host Ports
B Memory Stick

Clear Port Settings
Add Additional Device

Keyboard
b Mouse [~ Manufacturer ~ Driver
=l gz Connectors <System> Mo Driver Selected
Generic MQTT ABB DF1 Master Versian 1.02
Amazon MQTT ACTech DF1 Master via PCCC/EIP Version 1,01
Azure MQTT Acromag DF1 Slave Version 1.00
Adenus Encapsulated DF1 Master Version 1.00
Sparkplg AT T T Mic 6500 Master Version .01
. Cumulocity REST Alstom Mative Tag Addressing Version 1.01
= B services Automation Direct - Koyo Native Tags via LSK file Version 1.04
§s OPC UA server BACnet Native Tags via L5K file Enhanced Version 2,01
&3 Time Manager Banner
[ FTP Server Becknoft
Beta LaserMike
o33 Sync Manager

[ Mail Manager

@ SQL Sync Total of 100 Drivers Available.
£ I Comms Modules

1§ siot1

1§ siot2

Find the Allen-Bradley Micro800 Master communications driver as shown
above and click OK.

In Crimson click on the PLC device.

| avigation Pame, 3K | Communications - Network - Potocol 1 PLCL
S ew= | <
& Communications
B g3 Network
El ¥ Protocol 1 - Micro800
om Pt Tag Names
S Protocol 2
i~ Protocol 3 Manage... ] [ Import.. ] I Expart..
S Protocol 4
B &) Serial Ports
=) RS-232 Program Part
=) RS485 Comms Port A IP Address:
) RS-232 Comms Port
=) RS485 Comms Port B
) & USE Host Ports
B Memory Stick Settings

5
Keyboard r
b Mouse Spanning Reads: Enabled =
5] Connectors Transactional Writes: Enabled -

Device Settings

>

Enable Device:  Yes -

Device Options
192.168.1.100
Transaction Timeout: | 1000 =

m

[&5 Time Manager
[ FTP Server
+3 Sync Manager
() Mail Manager
_& SQL Sync

Generic MQTT
Amaon QT Preempt Other Devics:
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ice

m Delete This Device
Add Gateway Block

Create Data Tags
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Device settings are available as follows:
IP Address: This is the IP address of the target Micro800 PLC.

Transaction Timeout: This is the amount of time that the driver will
wait before a transaction is considered to have failed. Shorter times
will detect failures sooner, but longer times will be more tolerant of
slow connections.

Tag Creation

The driver maintains a list of tag names that correspond to the tags
configured in the Micro800 PLC. A tag import mechanism is provided, but
these tags can also be manually created.

To create a tag, click on the Manage button from the device configuration

page:

Communications - Network - Protocol 1 - PLC2

Device Settings

Enable Device:  Yes -

Tag Nai

Manage... Impaort... l l Export...

Device Options

1P Address: [192.168.1.100 |

Transaction Timeout: | 1000 =1 ms

The following dialog will appear:

Tag Mames Create Tags

[BooL -] [ create.. |

I:‘Array
EN | |

Details

Type:

Minimum:

Maximum:
- CIP Type:
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To create a new tag, select the appropriate type from the drop-down box:

~Tag Names ~ Create Tags

i oo - | Create... |
s

BOOL
LISIMNT
INT
- ] ]
. REAL
_ pSTRING
SINT
BYTE
LITNT
WORD
LIDINT
DWORD
bl TIME
— DATE

ULINT

LWORD
e

Tag Mame
|M3rTag

Enter the name of the tag as found in Connected Components Workbench
and click OK.

-~ Tag Mames ~ Create Tags

MyTag - (DIt v | create.. |
] Array

[t H | || | |

~ Dretails

Type:
Minimum:
Maximum:
- CIP Type:
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To create an array, click the Array checkbox and set how many

dimensions the array should be, up to a maximum of 3. This will enable a
corresponding box for each dimension. Enter the maximum size of the
array for each dimension. The dimensions are assumed to start at index

and span to the maximum dimension, inclusive. Then click create and

name the tag as above. Use driver v1.01+ in Crimson 3.1+ for support of

string arrays.

~Tag Mames

BigArray
Counterval
CountUpBit
CountUpDone
CountUpReset
DINT_Array
DoubleArray
Global_add_bit
Global_DINT
Global_REAL
Global_reset_bit
Global_STRING
MultiArray
MyTag

Cimmlafrras

-

~ Create Tags

(DT

v][ Create... ]

Array

Details

Type:

Minimum:
Maximum:
P Type:
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Tag Import and Export

This section will describe the procedure to export tags from Connected
Components Workbench and then import the file into Crimson 3.0.

First, open the project for the Micro800 PLC in Connected Components
Workbench. There are two ways to export the tags in the project to a file.

The first way is to select the Device menu from the main menu bar. Then
select Export->Variables to Excel:

H MicroTest - Connected nents Workbench ard Editi

lFile Edit View Device | Tools Communications Window Help
Y = H| & Configure

: % Build

Y  Connect... F7

Project Organizer :
b Downlead..

r)(

MName: MicroTest
! Upload..

| MyController Diagnose '

Secure Lt
%
Change Controller... hose  Secure

Import 3

Export 3 -
=) Document Generator (print) _E"] Variables to Excel...
—

uuuuuuuu

L) Ll [
B User-Defined Function Blod ot

12345

H L e G |
o B surren @ wson-meacey ||| 57040

Alternatively, right-click on the controller's name, and select
Export->Variables to Excel:

Project Organizer

MName: MicroTest

- [ Build

E| 57 Connect... F
'
t

Download

Upload

........ ﬁ Diagnose ]

Secure 4

Bl E -
S Parameters

B 4o Change Controller...

Import 3

Export 4 fi z E_
........ {% % Cut Ctrl+X _@ Variables to Excel...
53 Copy Ctrl+C

X Delete Del
Rename Controller - General

Y Paste Cirl+V Name: MyCont

E-]

= Document Generator (print)

Properties Alt+Enter
|I| i - Ethemet

Description:

ALLEN-BRADLEY MICRO800 SERIES DRIVER INFORMATION SHEET FOR CRIMSON V3.0+



A dialog will appear. Select the desired location and name for the
exported file and click the Export button:

Variable Export/Import - Microg20 * O X
Import Variables | Export Variables
File name | Uh\Desktop\test.uls | [ Browse
...
"‘ Cancel

Now the variables are in a spreadsheet file in Excel format, but Crimson
3.0 is unable to read Excel files directly. The file will need to be saved as a
Comma Separated Values (CSV) file as descibed below.

First, open the exported spreadsheet file in Excel. Then, select
File->Save As from the main menu bar. Select the CSV file type from the
drop-down menu, and save the file:

File name: testxls

Save as type: [Excel. 97-2003 Workbook (*xls)

A . Excel Workbook ("xl=x)
e Excel Macro-Enabled Workbook (*.axlsm)
Excel Binary Workbook (*.xlsh)
Excel 97-2003 Workbook (*.xls)
HML Data (*xmnl)
Single File Web Page (*.mht*.mhtml)
=« Hide Folders Web Page (*.htm;*.html]
Excel Ternplate [*.xlte)
Excel Macro-Enabled Template (*.xitm)

23 Excel 97-2003 Template (*xlt)
24 Text (Tab delimited) (*.txt)

25 Unicode Text (*.tut)

26 KML Spreadsheet 2003 (*.xml)
27 .

28 o —— T

29 Text (Macintosh) (*.txt)

30 Text (M5-DOS) (*et)

31 C5V (Macintosh] (*.csv)

Now go to Crimson 3.0, and click on the import button in the driver's
configuration page:
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Tag MNames

Manage... ‘ " Export...

Use the file selection dialog to navigate to the location where the CSV file
was saved. Click the Open button and the tags in the file will be
automatically created and are available to map in Crimson 3.0.

Tags can also be exported from Crimson 3.0 to a CSV file. Select the
export button and use the dialog to select a name and location for the
exported file. This file can be imported in other Crimson 3.0 databases.

Mapping to Crimson 3.0+ Tags

The “Select Address” dialog box can be found by selecting the device
representing the Micro800 device in the Source drop down box of a Tag created
in the Data Tag category in Crimson.

[« NS s = N T [N R e R NN = N2

\lanigation Pans i | Data Tags - Tagl

azNew - [T D¢ 2y O Data | Format | Colors | Alarms | Triggers | Plot | security|
=

= t:_;:fs Data Source

Source: ~ Internal

Extent: Internal
General
Complex
Treat As: Tag -
Mew Tag...
storage: Master
Data Scaling —b
Select Address 2
Tag Mames Address
MEBooIArrai - MyDintArray
MyInt&rray 1 3 3
MyLintArray | | | | | |
MyMewVar =
MySintArray :
MyStringArrayl Dt
MyUdintArray Type: Long as Long
MyUintaArray . .
MyUsintArray Minimum: MyDintArray[0, 0, 0]
tagBOOL Maximum: MyDintArray[s, 5, 5]
tagBYTE
tagDATE CIP Type: DINT
tagDINT
tagDWORD il
+anThIT
l QK ] l Cancel ]

Highlight the desired tag name and click OK. If the tag name represents
an array, enter the desired offsets into the offset boxes and click OK.
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For array assignments set the Extent field in the Data Source group to a
value consistent with the assigned Source index and the array length as

created or imported.

X | Data Tags - TagsPLCL.MyDintArray

aglien o i XX an o

L-'a Data Tags

=l [ TagsPLCL
3 myBoolarray
MyDintArray
B MyIntArray
MyLintArray
n MyMewVar
MySintArray
@ wmystringArrayl
MyUdintArray
MyUintArray
UintArray2
MyUsintArray

$ampvTE

String Access

|

Dats | Format | Colors | Alarms | Triggers | Plot | security|

* ||| pata source

Source: (v | [myDintamayitz3)

Manipulation: [None -

Treat As: [signed integer -

Access: [Read and write |
= Read Mode:  [On Demand -

MNon-Retentive

Strings should be assigned to a string tag with the Data Source
Packing element set to None as shown below.

R T MU= G
MySintArray
@ MystringArrayl
MyUdintArray
MyUintArray
UintArray2
MyUsintArray
[ tageoOL
tagBYTE
tagDATE
tagDINT
tagDWORD
tagINT
tagLINT
B writeLlINT
B writeLREAL
taglREAL
[ ReadLREAL
[5] ReadLINT
tagLlWORD
tagREAL
tagSINT
B tagsTR

Data Furmatl Colors | Security

Data Source
Source: [~ ma | [tagstr
Length: characters

Entire Array

MNon-Retentive

Data Simulation

m

Simulate As: [~ General | [

Data Actions

|

onwrite: [ General | |

|

Ensure that the Length property in the Data Source group is set to

the same value as specified in the tag import operation.

64-bit Data Access

Map 64-bit data types (LINT, ULINT, LWORD, LREAL) to a tag and
set the Extent property in the Data Source group to a value two
times the number of 64-bit values that this tag will represent.

agNew - | 3 3 S 0
MySintArray
[ MyStringArrayl
MyUdintArray
MyUintArray
UintArray2
MyUsintArray
3 tageoOL
tagBYTE

| tagDATE

[ tagDINT

tagDWORD
l tagINT

X tagLINT

Data |Format | Colors | Alarms | Triggers | Plot | security|
|| Data Source
Source: [rma | [tagunt |

Extent: ~ Amray

Manipulation:

Treat As: Signed Integer
Acress: Read and Write

Read Maode: Entire Array

H
3
H
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Use the following user functions to get double values.

cstring AsTextL64(data, radix, count) for integers
cstring AsTextR64(data) for reals

Where data is the first element in the array of the double
value that will be passed as a string, radix is the number
base to be used and countis the number of digits to
generate.

Data Tags - TagsPLCL.ReadLINT

Data |Format| Colors | Securityl

Data Source

Source: [ General | |AsTextle4itaglINTOL,L0,20] | [Editu. |

16

None

Read Only
Entire Array

Mon-Retentive

Use the following user functions to set double values.

void TextTolL64(input, output) for integers
void TextToR64(/nput, output) for reals

Where /nputis a string representing a double value and
outputis the first element in the array of the double value to
be set.

Image Button 3 Properties =

Button | Show | Action

Action Mode

Operation: | User Defined b

Actill Edit General Action

Editor

TextToL64 (TagsPLCl.WriteLINT, TagsPLCl.tagLINT[Q], 10)

Action Control

Protection: [Nune -

Enable: lv General ] | |
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Crimson 3.1+ Auto Mapped Tag Creation

Red Lion’s Micro800 driver version v1.01+ also supports Crimson 3.1+
automatically mapped tag creation from an imported CSV file.

First, follow the steps in the previous Tag Import and Export section to
produce a CSV file suitable for import.

Next, in Crimson 3.1+ go to the Communications category and select the
PLC device that represents the Micro800 device.

m X |G licati - Network - Protocol 1 - PLC1
ﬂ‘ LI x Device Settings
‘%J Communications -
= & Network Enable Device:  Yes -
=] Protocol 1 - Microg00
Tag Names
T Protocol 2
E? Protocol 3 [ Manage... ] [ Import... ] [ Export...
i Protocol 4
B &) Serial Ports , ,
) RS-232 Program Port (e

=) RS-485 Comms Port A 1P Address: 192.168.1.100

=) R5-232 Comms Part
=) R5-485 Comms Part B Transaction Timeout: | 1000 “l'm

(=) & USE Host Ports
B Memory Stick Advanced Settings

5
Keyboard
i Mouse Spanning Reads: Enabled -
= 58 Connectors Transactional Writes: | Enabled v
Generic MQTT
Amazon MQTT Preempt Other Devices: _

m

Azure MQTT §
Sparkplug MQTT Favor UT Writes: _
Cumulocity REST Comms Delay: _ "

= f}é Services
@ OPC UA Server
B3 Time Manager
[, FTP Server L. Delete This Device
pil Sync Manager
[ Mail Manager
[¥3 sQLsync Create Data Tags

= f; Comms Modules

Device Commands

Add Gateway Block

Click on the Create Data Tags link in the Device Command group.

Allen Bradley Tag Configuration

Folder

Falder Mame: |TagsPLC1. |

MName and Label

Define: [Tag Names 'l
MName
[ alias
|:| Caomment

|:| Data Type

Information

Only those tag names with legal characters and length will be used to create automatically mapped data tags.

[ o ) [ concel |

ALLEN-BRADLEY MICRO800 SERIES DRIVER INFORMATION SHEET FOR CRIMSON V3.0+



The Folder Name defines the name of the folder in the Crimson’s Data
Tag category in which the newly created data tags will reside. Modify the
text if desired.

Use the UI elements in the Name and Label group to set the newly
created tags names and/or labels based upon aspect(s) of the imported
file.

Folder

Folder Mame: |TagsPLC‘L

MName and Label

Define: |Tag Names
"

Tag Labels
[ atias

D Comment

|:| Data Type

Information

Only those tag names with legal characters and length will be used to create automatically mapped data tags.

Click OK which will launch the Open File dialog box.

(ol | ).+ Microson

QOrganize ~ New folder

SX Favorites Name ’ Date medified Type Size
Bl Desktop ﬁ CCW_Export.csv 8/30/2018 3:01 PM Microsoft Excel C... 2KB
& Downloads %] Global.csv 9/25/2018 7:40 AM  Microsoft Excel C... 735 KB
] Recent Places @ Global2.csv 9/28/201810:29 AM  Microsoft Excel C... 740 KB
J‘ Music ﬁ Local.csv 9/6/2018 1:41 PM Microsoft Excel C... 1KB

Select the desired previously prepared for import CSV file and click OK.

Crimson will attempt to replace illegal characters with an underscore.
Any remaining duplicate or illegal tag name details are shown in the
Micro800 Import Error Dialog.

Micro800 Impert Error Dialog | 2 |

The following Import error(s) have occurred,

Errar List

tagWORDE971234567591234567591234...  Tag name length exceeds 40 characters. -
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Tags are now auto created and exist in the Data Tags category in Crimson
available for further configuration and usage.

W‘ i Data Tags - TagsPLC1
= )
agiNew - | T Xy - Folder Details

[i Data Tags -
O || Osscivon [Glova
F’ MyBoolArray Class: |
MyDintArray
MyIntarray
MyLintArray
MyNewVar
MySintArray
@ mystringArrayl
ﬂ MyUdintArray
MyUintArray
MyUsintArray
1 tagBOOL
tagBYTE
tagDATE
tagDINT
tagDWORD
tagINT

Ed tagunT
tagLREAL
tagLWORD
& taorEAL
tagSINT

B tagsTR
tagTIME
tagUDINT B
tagUINT
tagULINT
tagUSINT

m

¢ icati

Data Tags

2

Note array tags Read Mode property (in the Data Source group) is initially
set to Entire Array. To improve efficiency the Read Mode can be set to On
Demand as shown below.

|NavigationPane X, | Data Tags - TagsPLCLMyUintArray

42 New - | [T > % )’—\' Data ‘ Fnrmatl Colors IAIarms I Triggers I Plot I Secur\tyl

-
= [ TagsPLCL ||| Pata source

3 myBoolarray 3 - MyUintarray[0,0,0 ks

£ Moty Source: [ PLC1 ] | y y10,0,0] ‘

[ MylntArray Extent:

MyLintArray

MyNewVar Manipulation: [None VI

ﬂ MySintArray

m MyStringArrayl Treat As: [Unswgned Integer 'l

MyUdintArray Access: [Read and write -

[ Uintarray2 = Read Mode: [ On Demand -

MyUsintArray

[ tageoOL Storage: Non-Retentive

B3 tagByTE

tagDATE Data Scaling

taQDINT Scaling: Do Mot Seale -

B tagDWoRD '

tagINT DataFrom: |+ Genera Edit...

tagLINT

E WriteLINT Data To: ~ Genera Edit...

Multi-dimensional arrays will have an array tag created to access a
single dimension of the array.
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—

Data Tags - TagsPLCL.MyLintArray

Tag 20 ()

MyDintArray
MyIntarray
MyLintArray

[ ReadLINTAmay
@& writelINTArray
@ wiriteLINTArray_1
& writeLINTArray_2
MyMewVar
MyMewVar_1

To access another single dimension of the multidimensional array — right
click on the created array tag and select Smart Duplicate.

- :

Manipulation:
Storage: MNon-Retentive

Data Tags - TagsPLC1.MyLintArray

sl L X B bots [FomatCotors [aiams [Tiages [Pot[secui]
||| = [Er TagsPLCL p
i ReadlREAL I Data Source
| E ‘;‘V’SELT:AL Source: [' PLCL ] ‘MyLintArray[o,n,n] |
lyBoolArray
& o oot (]

Tag20 §

ﬁ“ Mew ~ 9 a % e Data |Fu:mat | Colors |Al.arms IT:iggers | Flot | Semm‘yl

= [ TagsPLCL “ || Data Source
[ ReadLREAL |
Emgztﬁzy Source: [T ra | [Mylntarayo) |
@ WriteLINT Extent:

a MyDintArray
a MyIntArray

Readl New 4
@ wiritel
Sync Panes
@ wiitel
@ wiritel cut
MyNey

Copy
Delete

m

Smart Duplicate

Find Usage
Add to Watch List

Rename

Private Access

Copy From »

[x]
o+
a
=]
a

)

tagINT

Select the newly created tag and click on the Pick... button in the Data

Manipulation: [None

zl

Source group of the Data tab.

TR

(NavigationPane X

||| = & TagsPLCL

[ ReadLREAL
& writeLREAL
P myBoolArray
@ writelint
MyDintArray
MylntArray
MyLintarray
MyLintArray_1
[ ReadLINTAmray
& writeLINTArray
@ WritelINTArray_1
B writelINTArray_2
MyNewVar
MyMNewVar_1
[ ReadLINT
MySintrray
@ MyStringArrayl
MyUdintarray
MyUintArray
MyUsintArray
M tageoOL
tagBYTE
tagDATE
tagDINT
tagDWORD
tagINT
tagLINT

A +an1REAL

Data Tags - TagsPLCL.MyLintArray 1

Data | Format I Colors I Alarms | Triggers | Plot

| Secunryl

Treat As: [Engneu Integer ']
Access: [Reau and Write V]
Read Mode: [ Entire Array -
Storage: Non-Retentive

Data Scaling
Secaling: Do Mot Scale i
Data From: w General Edit...
Data Ta: ¥ General Edit...
Display From: |+ General Edit...
Display To: w General Edit...

Tag33 D

Data Source

Source: [ w PLCL

] | MyLintArray[0,1,0

Extent:

Manipulation: [Nol\e

™

Treat As: [Sigmd Integer

)

Access: [Rniﬂ and Write

|

Select Address

~ Tag Names

MyEoalArray
MyDintArray

MyNewVar
MySintArray
MyStringArrayl
MyUdintArray
MyUintArray
MyUsintArray
tagBOOL
tagBYTE
tagDATE
tagDINT
tagDWORD

+anThT

MEIntArraE

[~ Address

- MylLintArray

(EN

[~ Details
Type:
Minimum:
Maximum:
CIP Type:

Long as Long
MyLintArray[0, 0, 0]
MyLintArray(S, 5, 5]
LINT

i B

T

Enter the desired starting element and click OK.
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Cable Information

RS232 Serial Connection

Micro800 Red Lion Device
TX 2 Rx
Rx 5 Tx
G 3/4 COMM

Ethernet — Standard Ethernet Cable

Revision History

02/04/2016 — Created

08/30/2018 — Updated to new Crimson 3.0+ information sheet format.
10/18/2018 — Added Crimson 3.1+ Auto Mapped Tag Creation section.
10/22/2018 — Added 64-bit data access notes.

02/20/2019 — Added clarification of string array support for driver v1.01+.
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